Chapter 5
Intermediate Forth Tutorial

Note: This chapter is shared between the JForth Manual and the HMSL manual. Information specific
to HMSL on the Macintosh or JForth on the Amigais noted as such.

Editing Programs in Files

Asyour programs get larger, it becomes impractical to type them in fresh each time. To develop
software of any size, you'll need to keep your source code in files. You can then compile directly from
these files instead of from the keyboard. Forth programs can be created like programs in other
languages by using atext editor. Y ou can use any text editor that you like. Beware of word processing
programs because they will put strange information in the file related to margins, fonts, etc. If you use
aword processor, save thefilein text only mode. We recommend that you use the text editor that
comes included with your Forth package. The process of editing differs between computers. Please
read the appropriate section for your machine

Editing on the Macintosh: To create anew file, select New from the File menu whilein Forth. Text
can be enterred in the standard Macintosh style. Look in the Edit menu for commands like Cut, Copy
and Paste, Upper and Lower case conversion.

Editing on the Amiga: The editor supplied with JForth is called Textra. 1t was written by Mike Haas
using JForth. Full documentation on Textrais supplied in the JTX:DOCS directory. Y ou will
probably want to install Textra by either copying it to your C: directory (or any other directory in your
current AmigaDOS path) or to a place convienient for double-clicking it'sicon. Textracan befoundin
the JTX: directory on the JTOOLS: disk. Assuming Textraisinstalled, either double-click on it'sicon
or enter:

RUN TEXTRA

If you want to open an existing file, select it using the file selector. To start with afresh file, hit
CANCEL. Look in the Project menu for commands to save files and to create new files.

Y ou can move through the file using cursor keys or the mouse. Drag the mouse (while holding down
the left mouse button) to select text. Selected text can be Cut, Copied, or Pasted using commandsin
the Edit menu.

If you have ARexx, look in Chapter 23, AREXX Support for instructions on how to connect JForth and
Textrafor easy compilation.

Sample Program

Enter into your file, the following code.
\ Sanpl e Forth Code
\ Aut hor: your name
SQUARE ( n -- n*n , square nunber )
DUP *

TEST. SQUARE ( -- )

CR." 7 squared ="
7 SQUARE . CR
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Now save the file as described for your machine.

The text following the \ character istreated as acomment. Thiswould be aREM statement in BASIC
ora/*---*/in'C'. Thetextin parenthesesis aso acomment.

Save thisfile using the "Save As..." menu option, giving it the name SAMPLE in the process.

INCLUDE the Program

"INCLUDE" in Forth means to compile from afile.

Compiling on the Macintosh: To compile afile directly from the editor, select the "Include From
Editor" command from the Include menu. If an error is encountered, it will be highlighted in the
editor. Error messages will appear in the Forth window. Y ou can also compile your program from
HMSL by selecting "Include from File..." from the File menu. Usethe dialog to select thefile you
just created.

Compiling on the Amiga: If you have ARexx installed, and configured Textra and JForth as

described in Chapter 23, you can compile afile from Textra by simply hitting whichever function key

isassigned to the jcompile command. If an error is encountered, it will be highlighted in the editor.
Error messages will appear in the Forth window.

Y ou can aso compile from afile using the INCLUDE command. If you saved your file as
WORK:SAMPLE, then compileit by entering:

| NCLUDE WORK: SAMPLE
Forth will compile your file and tell you how many bytesit has added to the dictionary. To test your
word, enter:

TEST. SQUARE
Y our two words, SQUARE and TEST.SQUARE are now in the Forth dictionary. We can now do

something that is very unusual in a programming language. We can "uncompile" the code by telling
Forth to FORGET it. Enter:

FORGET SQUARE

This removes SQUARE and everything that followsit, ie. TEST.SQUARE, from the dictionary. If
you now try to execute TEST.SQUARE it won't be found.

Now let's make some changes to our file and reload it. Go back into the editor and make the following

changes: (1) Change TEST.SQUARE to use 15 instead of 7 then (2) Add thisline right before the
definition of SQUARE:

ANEW TASK- SAMPLE
Now Save your changes and go back to the Forth window.

Y ou're probably wondering what the line starting with ANEW was for. ANEW isaways used at the
beginning of afile. It defines aspecial marker word in the dictionary before the code. The word
typicaly has"TASK-" as a prefix followed by the name of the file. When you Relnclude afile,

ANEW will automatically FORGET the old code starting after the ANEW statement. This allows you

to Include afile over and over again without having to manually FORGET the first word. If the code
was not forgotten, the dictionary would eventualy fill up.

If you have a big project that needs lots of files, you can have afile that will load all the files you need.

Sometimes you need some code to be |oaded that may already be loaded. The word INCLUDE? will
only load codeif it isn't already in the dictionary. In this next example, | assume the fileis on the
volume WORK: and called SAMPLE. If not, please substitute the actual name. Enter:

FORGET TASK- SAMPLE

| NCLUDE? SQUARE WORK: SAMPLE

| NCLUDE? SQUARE WORK: SAMPLE
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Only the first INCLUDE? will result in the file being loaded.

Variables

Forth does not rely as heavily on the use of variables as other compiled languages. Thisis because
values normally reside on the stack. There are situations, of course, where variables are required. To
create avariable, use the word VARIABLE asfollows:

VARI ABLE MY- VAR
This created avariable named MY-VAR . A space in memory is now reserved to hold its 32-bit value.

Theword VARIABLE iswhat's known as a"defining word" since it creates new words in the
dictionary. Now enter:

MY- VAR .
The number you see isthe address, or location, of the memory that was reserved for MY-VAR. To
store data into memory you use theword ! , pronounced "store”. It looks like an exclamation point, but
to a Forth programmer it is the way to write 32-bit datato memory. To read the value contained in
memory at a given address, use the Forth word @ , pronounced "fetch". Try entering the following:

513 MY-VAR !

MY- VAR @.
This setsthe variable MY-VAR to 513, then reads the value back and printsit. The stack diagrams for
these words follows:

@ ( address -- value , FETCH val ue FROM address in nenory )

I' ( value address -- , STORE value TO address in nenory )
VARI ABLE ( <name> -- , define a 4 byte nenory storage | ocation)
A handy word for checking the value of avariableis ? , pronounced "question”. Try entering:
MY- VAR ?
If ?wasn't defined, we could defineit as:
? ( address -- , look at variable )
@.

Imagine you are writing a game and you want to keep track of the highest score. Y ou could keep the
highest scorein avariable. When you reported a new score, you could check it aginst the highest
score. Try entering this code in afile as described in the previous section:
VARI ABLE H GH SCORE
REPORT. SCORE ( score -- , print out score )
DUP CR ." Your Score =" . CR
H GH SCORE @ MAX  ( cal cul ate new high )
DUP ." Highest Score =" . CR
H GH SCORE ! ( update variable )
Save thefile to disk, then compile this code using the INCLUDE word. Test your word as follows:
123 REPORT. SCORE
9845 REPORT. SCORE
534 REPORT. SCORE
The Forth words @ and ! work on 32-bit quantities. Some Forths are "16-bit" Forths. They fetch and

store 16-bit quantities. Forth has some words that will work on 8 and 16-bit values. C@ and C! work
for 8-bit bytes. The'C' stands for "Character" since ASCII characters are 8-bit numbers. Use W@ and
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W! for 16-bit "Words."

Another useful word is+! , pronounced "plus store." It adds a value to a 32-bit value in memory. Try:
20 MY-VAR !
5 MY- VAR +!
MY- VAR @ .

Forth also provides some other words that are similar to VARIABLE. Look in the glossary for
VALUE and ARRAY. Alsolook at the section on "local variables' which are variables which only
exist on the stack while a Forth word is executing.

A word of warning about fetching and storing to memory: Y ou have now learned enough about Forth
to be dangerous. The operation of a computer is based on having the right numbers in the right place
in memory. Y ou now know how to write new numbersto any placein memory. Since an addressis
just a number, you could, but shouldn't, enter:

73 253000 ! ( Do NOT do this. )

The 253000 would be treated as an address and you would set that memory location to 73. | have no
ideawhat will happen after that, maybe nothing. Thiswould be like firing arifle through the walls of
your apartment building. Y ou don't know who or what you are going to hit. Since you share memory
with other programsincluding the operating system, you could easily cause the computer to behave
strangely, even crash. Don't let this bother you too much, however. Crashing a computer, unlike
crashing a car, does not hurt the computer. You just have to reboot. The worst that could happen is
that if you crash while the computer iswriting to adisk, you could lose afile. That's why we make
backups. This same potential problem existsin any powerful language, not just Forth. This might be
lesslikely in BASIC, however, because BASIC protects you from alot of things, including the danger
of writing powerful programs.

Another way to get into trouble isto do what's called an "odd address memory access.” The 68000
processor arranges words and longwords, 16 and 32 bit numbers, on even addresses. If you doa @ or
I, or W@ or W! , to an odd address, the 68000 processor will take exception to this and try to abort.

Forth gives you some protection from this by trapping this exception and returning you to the OK
prompt. If you really need to access data on an odd address, check out the words ODD@ and ODD! in
the glossary. C@ and C! work fine on both odd and even addresses.

("Odd address errors' are not possible on Amiga's that use 68020 CPU's and later...they are made to
perform thistype of operation. However, if you have one of these newer CPU's, you should aways be
mindful of al the Amigas which DO use 68000's and avoid doing such operations.)

Thereason | am spending so much time on thisisthat if your program is crashing and getting those
little pictures of bombs, you may likely be storing somewhere you shouldn't be.

Constants

If you have a number that is appearing often in your program, we recommend that you defineit asa
"constant.” Enter:

128 CONSTANT MAX_CHARS
MAX_CHARS .

We just defined aword called MAX_CHARS that returns the value on the stack when it was defined.
It cannot be changed unless you edit the program and recompile. Using CONSTANT can improve the
readability of your programs and reduce some bugs. Imagineif you refer to the number 128 very often
in your program, say 8 times. Then you decide to change this number to 256. If you globally change
128 to 256 you might change something you didn't intend to. 1f you change it by hand you might miss
one, especialy if your program occupies more than onefile. Using CONSTANT will make it easy to
change. The code that resultsis equally as fast and small as putting the numbersin directly. |
recommend defining a constant for almost any number.
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Logical Operators

These next two sections are concerned with decision making. Thisfirst section deals with answering
questions like "Is this value too large?' or "Does the guess match the answer?'. The answersto
questions like these are either TRUE or FALSE. Forth usesaO to represent FALSE anda-1to
represent TRUE. TRUE and FAL SE have been capitalized because they have been defined as Forth
constants. Try entering:

23 71 = .
18 18 = .
Y ou will notice that the first line printed a 0, or FALSE, and the second line a-1, or TRUE. The equal

signin Forth is used as a question, not a statement. It asks whether the top two items on the stack are
equal. It does not set them equal. There are other questions that you can ask. Enter:

23 198 < .
23 198 > .
254 15 > .
In California, the drinking age for alcohol is21. Y ou could write asimple word now to help
bartenders. Enter:
DRINK? ( age -- flag , can this person drink? )
20 >

20 DRI NK? .
21 DRI NK? .
43 DRI NK? .

Theword FLAG in the stack diagram above refersto alogical value.

Forth provides special words for comparing anumber to 0. They are 0= 0> and 0<. Using 0> is faster
than calling 0 and > separately. Enter:

23 0> . ( print -1)

-23 0> . ( print 0)

23 0=. ( print 0)
For more complex decisions, you can use the Boolean operators OR , AND , and NOT . OR returns a
TRUE if either one or both of the top two stack items are true.

TRUE TRUE OR .

TRUE FALSE OR .

FALSE FALSE OR .

AND only returns a TRUE if both of them are true.
TRUE TRUE AND .
TRUE FALSE AND .

NOT reversesthe value of the flag on the stack. Enter:
TRUE .
TRUE NOT .

Logical operators can be combined.

56 3 > 56 123 < AND .
23 45 = 23 23 = R
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Here are stack diagrams for some of these words. See the glossary for a more complete list.
<( ab--flag, flagis trueif Ais less than B)

>( ab--flag, flag is true if Ais greater than B)

=( ab--flag, flagis trueif Ais equal to B)

0= ( a-- flag, true if a equals zero)

OR (ab-- al|b, performlogical OR of bits in A and B)
AND ( a b -- a& , performlogical AND of bits in A and B)
NOT ( flag -- opposite-flag , true if false, false if true )
Problem:

1) Write aword called LOWERCA SE? that returns TRUE if the number on top of the stack isan
ASCII lowercase character. An ASCII 'a is97. An ASCII 'Z'is122 . Test using the characters™ A

aqz{".
ASCI | A LONERCASE? . ( should print 0)
ASCI | a LONERCASE? . ( should print -1)

Flow of Control

Y ou will now use the TRUE and FAL SE flags you learned to generate in the last section. The "flow of
control" words accept flags from the stack, and then possibly "branch” depending on the value. Enter
the following code.

.L ( flag -- , print logical value )

IF ." True value on stack!"
ELSE ." Fal se value on stack!"
THEN

0.L

FALSE . L

TRUE . L

23 7 < .L

Y ou can see that when a TRUE was on the stack, the first part got executed. If a FALSE was on the
stack, then the first part was skipped, and the second part was executed. One thing you will find
interesting is that if you enter:

23 . L
the value on the stack will be treated as true. The flow of control words consider any value that does
not equal zero to be TRUE.

The EL SE word isoptional inthe IF...THEN construct. Try the following:

Bl GBBUCKS? ( anmount -- )
1000 >
IF ." That's TOO expensive!"
THEN

531 BI GBUCKS?
1021 BI GBUCKS?
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Forth also has a CASE statement similar to switch() in'C'. Enter:
TESTCASE ( N -- , respond appropriately )
CASE
0 OF ." Just a zero!" ENDOF
1 O ." All is ONE'" ENDOF
2 OF WORDS ENDOF
DUP . ." Invalid Input!”
ENDCASE CR

0 TESTCASE
1 TESTCASE
5 TESTCASE

See CASE in the glossary for more information.
Problems:

1) Write aword called DEDUCT that subtracts a value from a variable containing your checking
account balance. Assume the balanceisin dollars. Print the balance. Print awarning if the balance
is negative.

VARI ABLE ACCOUNT

DEDUCT ( n -- , subtract N from bal ance )
2222222222222222222222?222?22?22?2?? ( you fill this in)

300 ACCOUNT ! ( initial funds )

40 DEDUCT ( prints 260 )

200 DEDUCT ( print 60 )

100 DEDUCT ( print -40 and gi ve warning! )

Loops
Another useful pair of wordsis BEGIN...UNTIL . These are used to loop until agiven condition is

true. Try this:
YAKYAK ( -- )

BEG N
." 1 could talk all day!"™ CR
?TERM NAL
UNTI L
YAKYAK

Thisword will keep running until you hit akey on the keyboard. Theword ?TERMINAL will return

TRUE if akey has been hit. (You could then immediately call KEY if you wish to know what key was
hit.)
If you know how many times you want a loop to execute, you can use the DO...L OOP construct.
Enter:
SPELL
" ba"
4 0 DO

LOOP

na
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Thiswill print "ba" followed by four occurrences of "na"'. The ending valueis placed on the stack
before the beginning value. Be careful that you don't pass the valuesin reverse. Forth will go "the
long way around" which could take awhile. The reason for this order isto make it easier to pass the
loop count into aword on the stack. Consider the following word for doing character graphics. Enter:
PLOT# ( n -- )
0 DO
ASCl | - EMT
LOOP CR

CR 9 PLOT# 37 PLOT#

If you want to access the loop counter you can usetheword | . Hereis asimpleword that dumps
numbers and their associated ASCII characters.

.CHARS ( end start -- , dunp characters )
DO
CRI . I EMT
LOOP CR
80 64 . CHARS

Y ou could make this word safe by making sure that the parameters are in the right order. The word
-2SORT will take two numbers and leave the smallest on top. Enter:
SAFE.CHARS ( nl1 n2 -- )
-2SORT ( put smallest on top )
. CHARS

40 50 SAFE. CHARS
50 40 SAFE. CHARS

If you want to leave a DO LOOP before it finishes, you can use theword LEAVE. Enter:
ANNOY. ME ( -- , Sing! )
50000 O
DO 50000 | -
." bottles of beer on the wall." CR
?TERM NAL ( was a key hit )
IF ." OK I'lIl shut up!"™ CR
LEAVE ( quit | ooping )
THEN
LOooP
Please consult the manual to learn about the following words +L OOP and RETURN .

Another useful looping construct isthe BEGIN WHILE REPEAT loop. Thisallows you to make a
test each time through the loop before you actually do something. The word WHILE will continue
looping if the flag on the stack is True. Suppose you want to write aword called SHOWCHARS that
prompts the user to hit akey, waits for akey to be hit, then prints the key as a decimal number and as a
character. It should keep doing thisin aloop until thekey isa'q or a'Q". Hereisaword that will do
this:

SHOMCHARS ( -- , loop on chars till
BEG N

a )

Ht a key or 'q" to quit:" KEY ( wait for a key )
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DUP ASCIl q = ( -- char flag)
OVER ASCII Q = OR NOT

WVHLE ( -- char , loop if not "q" or 'Q )
CR." Key =" DUP . EMT CR

REPEAT DROP

Text I/0O

You learned earlier how to do single character 1/0. This section concentrates on using strings of
characters. A text string in Forth consists of a character count in the first byte, followed immediately
by the characters themselves. A character string can be created using the Forth word " , pronounced
‘quote’. Note that you must follow the " by one space. Any text following that spaceis copied to a
specia areain memory called the PAD. Thetext string isterminated by an ending " . Enter:

" Fred"

The number that was printed was the address of the start of the string. 1t should be a byte that contains
the number of characters. Now enter:

" Fred" C@.
Y ou should see a4 printed. Remember that C@ fetches one character/byte at the address on the stack.
By adding one to this address and doing a C@, you should see the first character. Enter:

" Fred" 1+ DUP COAEM T

1+ DUP CQEM T

1+ CQEM T
Using this method, you could type out any string. Luckily, there are two words that make this process
much easier. Enter:

" Hello" COUNT .S

TYPE
Theword COUNT extracts the number of characters and their starting address. TY PE accepts the
output of count and prints those characters. COUNT will only work with strings of less than 256

characters, since 255 is the largest number that can be stored in the count byte. TY PE will, however,
work with longer strings since the length is on the stack. Their stack diagrams follow:

COUNT ( $addr -- addr #bytes , extract string information )

TYPE ( addr #bytes -- , output characters at addr )

The $addr is the address of a count byte. The dollar sign is often used to mark words that relate to
strings.

You can easily input a string using the word EXPECT. (Y ou may want to put these upcoming
examplesin afile since they are very handy.) The word EXPECT receives characters from the
keyboard and places them at any specified address. EXPECT takes input characters until a maximum
isreached or acarriage return is entered. The user variable SPAN contains the number of characters
entered. You can write aword for entering text. Enter:
INPUT$ ( -- $addr )

PAD 1+ ( leave roomfor byte count )

128 EXPECT ( recieve a nmaxi mumof 128 chars )

SPAN @ PAD C!' ( set byte count )

PAD ( return address of string )

Y ou could use thisin aprogram that writes form letters.
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FORM LETTER ( -- )
." Enter custoner's nane." CR
| NPUTS$
CR ." Dear " DUP COUNT TYPE CR
." Your cup that says " COUNT TYPE
." isinthe mil!" CR

EXPECT ( addr maxbytes -- , input text, save at address )

SPAN ( -- addr , contains nunber of chars EXPECT got )

Y ou can use your word INPUT$ to write aword that will read a number from the keyboard. Enter:

INPUT# ( -- Ntrue | false)
I NPUT$ ( get string )
NUVBER? ( convert to a string if valid)
| F DROP TRUE ( get rid of high cell )
ELSE FALSE
THEN

Thisword will return a single-precision number and a TRUE, or it will just return FALSE. The word
NUM BER? returns a double precision number if the input string contains a valid number. Double
precision numbers are 64-bit so we DROP the top 32 bits to get a single-precision 32 bit number.

Changing Numeric Base

Our numbering system is decimal, or "base 10." This means that a number like 527 is equal to (5* 100
+2*10 + 7*1). Theuse of 10 for the numeric baseis a completely arbitrary decision. It no doubt has
something to do with the fact that most people have 10 fingers (including thumbs). The Babylonians
used base 60, which is where we got saddled with the concept of 60 minutesin an hour. Computer
hardware uses base 2, or "binary”. A computer number like 1101 isequal to (1*8 + 1*4 + 0*2 + 1*1).
If you add these up, you get 8+4+1=13. A 10in binary is (1*2 + 0*1), or 2. Likewise 10 in any base
NisN.

Forth makes it very easy to explore different numeric bases because it can work in any base. Try
entering the following:

DECIMAL 6  BINARY .

11 +.

1101 DECI MAL .
Another useful numeric base is hexadecimal. which isbase 16. One problem with bases over 10 is

that our normal numbering system only has digits0to 9. For hex numbers we use the letters A to F for
the digits 10 to 15. Thus the hex number 3E7 is equal to (3*256 + 14*16 + 7*1). Try entering:

DECI MAL

12 . HEX

12 256 * 716 * + 10 + .S
DUP BI NARY . . HEX

A variable called BASE isused to keep track of the current numeric base. The words HEX ,
DECIMAL , and BINARY work by changing this variable. Y ou can change the base to anything you
want. Try:

DECI MAL

7 BASE !
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6 1+ .
BASE @ .

You arenow in base 7. When you fetched and printed the value of BASE, it said 10 because 7, in
base 7, is 10.

Y ou could define aword like .HEX for any base. What is needed is away to temporarily set the base
while anumber is printed, then restore it when we are through. Try the following word:

.BINARY ( N-- , print Nin Binary )
BASE @ ( save current base )
2 BASE ! ( set to binary )
SWAP . ( print number )
BASE ! ( restore base )
DECI MAL
22 . BI NARY

22 .

Answers to Problems

Logical Operators
LONERCASE? ( CHAR -- FLAG, true if |owercase )
DUP 123 <
SWAP 96 > AND

Flow of Control
DEDUCT ( n -- , subtract from account )
ACCOUNT @ ( -- n acc )
SWAP - DUP ACCOUNT ! ( -- acc' , update variable )
." Balance = $" DUP. CR ( -- acc' )
0< ( are we broke? )
I F ." Warning!! Your account is overdrawn!" CR
THEN
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